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/home/vagrant
├── practicals
│   ├── 01-string-deciphering
│   │   └── 33f46cac84fe0368f33a1e56712add18
│   ├── 02-diffing-cve-patch
│   │   ├── sgdisk-1
│   │   └── sgdisk-2
│   ├── 03-diffing-symbols-porting
│   │   ├── libsensorservice-1.so
│   │   └── libsensorservice-2.so
│   └── 04-firmware-diffing
│       ├── RAX30-V1.0.7.78_1.img
│       └── RAX30-V1.0.9.90_3.img
└── tools
    ├── diffing-documentation
    ├── ghidra_10.3.2_PUBLIC
    ├── idafree-8.3
    └── Sourcetrail

Virtual Machine

Ubuntu 22.04
workshop-bindiff.ova  [   ]

MD5: 456526f45a6f1f319acee7e2c69a1ff3

Size: 4.0 GB
User: vagrant
Pass: vagrant

https://files.quarkslab.com/3dac2dcd-bb92-4ac9-99cc-e517498i6978/quarkslab-binary-diffing.ova
https://files.quarkslab.com/3dac2dcd-bb92-4ac9-99cc-e517498i6978/quarkslab-binary-diffing.ova


The Team

Automated Analysis Team @ Quarkslab
(Reverse wide variety of targets and develop tooling to 

assists our security assessment)

Tools

Dynamic Analysis
QBDI dynamic binary instrumentation framework

Qtracer dynamic trace generator and analysis

Symbolic Execution
Triton symbolic execution framework

TritonDSE DSE and exploration library (whitebox fuzzing)

Fuzzing
PASTIS collaborative/distributed fuzzing

HF/QBDI Honggfuzz backed by QBDI

Firmware Analysis
Pandora whole firmware analysis engine

Pyrrha firmware cartography

QSig firmware 1-Day matching engine (discontinued)

Diffing
python-bindiff python library wrapping Bindiff

QBinDiff Binary Differ based on machine learning algorithm

Static Analysis
python-binexport python API to manipulate Binexport files

Quokka IDA plugin and python API to manipulate IDA disassembly

Deobfuscation Qsynthesis synthesis based deobfuscator (targeting MBAs) 33

https://qbdi.quarkslab.com
https://triton-library.github.io
https://github.com/quarkslab/tritondse
https://github.com/quarkslab/pastis/
https://github.com/quarkslab/pyrrha
https://github.com/quarkslab/qsig
https://github.com/quarkslab/python-bindiff
https://github.com/quarkslab/qbindiff
https://github.com/quarkslab/python-binexport
https://github.com/quarkslab/quokka
https://github.com/quarkslab/qsynthesis
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Today’s
focus
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Workshop Goal

Goal #1
Introducing use-cases and tools (we wrote) to 
speed-up and to automate reverse & diffing 

tasks.

Goal #2
Showing how to do whole firmware diffing.

55



Program Representation Levels

Source
Code

IR Assembly
(.asm)

Binary
(.elf)

compilation
(frontend)

compilation
(backend)

assembly

disassemblyIR liftingdecompilation

Will work at this level 
(syntactical form)

66



Warm-Up: Poll

Assembly (x64, ARM) ?

Format Analysis (ELF / PE) ?

IDA / Ghidra               ?

Python           ?

How familiar 
are you with

77



Scripting Reverse
Engineering



Scripting the Disassembly

Disassembler API
Run the scripting engine 
within the disassembler 

context.

Exporter
Approach that exports the 

disassembled program in a file to 
process it outside of disassembler.

✓ Usually many features

✗ Not portable across 
disassembler

✓ API independent from 
disassembler

✓ Can be more compact than 
disassembler database (.i64)

✗ Limited features

Study of 
exporters

99

https://blog.quarkslab.com/an-experimental-study-of-different-binary-exporters.html
https://blog.quarkslab.com/an-experimental-study-of-different-binary-exporters.html
https://blog.quarkslab.com/an-experimental-study-of-different-binary-exporters.html


Binary Exporters

Binexport Quokka

BinExport

Format used by bindiff now 
maintained by Google Developed by Quarkslab

Binexport Quokka
Disassemblers IDA Pro, Binja, Ghidra IDA Pro, Ghidra (~)

Format Protobuf, SQL Protobuf

Architectures x86, x64, ARM, Aarch64, DEX, Msil x86, x64, ARM, Aarch64

Data exhaustiveness ~ +++

Export file size ~ ++

Comparison
with Quokka

10 10

https://github.com/google/binexport
https://github.com/quarkslab/quokka
https://blog.quarkslab.com/quokka-a-fast-and-accurate-binary-exporter.html
https://blog.quarkslab.com/quokka-a-fast-and-accurate-binary-exporter.html


Binary Exporters: Installation

Binexport Quokka

Pl
ug

in
s

Py
th

on
 A

PI

1. Download the latest release
2. Unpack in the plugin directory
3. Ready to use

1. Download the latest release
2. Unpack in the plugin directory
3. Ready to use

(more documentation) (more documentation)

There is no built-in Python API to 
manipulate Binexport files!

⇓
(so we wrote it)

https://github.com/quarkslab/python-binexport

$ pip install python-binexport

$ pip install quokka-project

1111

https://github.com/google/binexport/releases/tag/v12-20230515-ghidra_10.3
https://github.com/quarkslab/quokka/releases
https://github.com/google/binexport#installation
https://quarkslab.github.io/quokka/installation/
https://github.com/quarkslab/python-binexport


Exporting an Executable

Binexport Quokka

UI
Py

th
on

IDA: Edit > Plugins > Binexport
Ghidra: File > Export Program >

      Binexport (v2) format

from binexport import ProgramBinExport

p = ProgramBinExport.from_binary_file(
    "file.exe")

$ idat64 -OQuokkaAuto:true -A \
  hello.exeSh

el
l

IDA: Edit > Plugins > Quokka  (Alt+A)
Ghidra: File > Export Program >

      Quokka format (not full)

$ binexporter file.exe

(wrapper to call idat64 with the good parameters)

from quokka import Program

p = Program.from_binary("file.exe")

1212

(idat64 not available in IDA Free)



Loading an Export

Binexport Quokka

from binexport import ProgramBinExport

p = ProgramBinExport("myprogram.BinExport")

for fun_addr, fun in p.items():

  for bb_addr, bb in fun.items():

    for inst_addr, inst in bb.instructions.items():

      for operand in inst.operands:

        for exp in operand.expressions:

          pass  # Do whatever

from quokka import Program

p = Program("prog.quokka", "prog.exe")

for fun_addr, fun in p.items():

  for bb_addr, bb in fun.blocks.items():

    for inst in bb.instructions:

      for operand in inst.operands:

        pass  # Do whatever

1313



Quokka Cheatsheet

function = program[0x804F7E0] # address known

function = program.get_function("main") # from name

# Find register access (read/write)

from quokka.types import RegAccessMode

instr = quokka.utils.find_register_access(

"eax", RegAccessMode.WRITE, instructions

)  # Find the instruction that writes into EAX

# Call references

call_refs = instr.call_references

address = call_refs[0].address

data = program.read_bytes(address, 8)

# Uses file offset

offset = addr - program.base_address

string = program.executable.read_string(offset)  

# Accessed registers in a instruction

regs_read, regs_write = cpst_inst.regs_access()

Register operations

Cross References (xrefs)

# Data references

data_refs = instr.data_references

address = data_refs[0].address

Accessing functions

cpst_inst = instr.cs_inst  # capstone object

Accessing capstone instruction

block = function[0x804F7E0] # address known

block = function.get_block(0x804F7E0)

Accessing basic blocks

Data access

[     documentation] 1414

https://quarkslab.github.io/quokka/
https://quarkslab.github.io/quokka/


Practical #0: Exporter usage

Take any executable on your system and

Tasks:

➤ Export the binary with Quokka or Binexport

➤ Load the program using Python API

➤ Write a script to iterate the content

Practical #0: Warm-Up

1515



Practical #01: String Deciphering

The binary is a well-known malware which cipher strings used internally.

Tasks:

➤ Export the binary with Quokka

➤ Reverse (manually) to:

○ find the ciphering function
○ understanding the deciphering algorithm

➤ Write a quokka script to decipher all strings

Practical #01

Will need find_register_access and read_bytes on the 
executable object.  

Tip

1616

Link: https://diffing.quarkslab.com/tutorials/ex1_string_decipher.html

https://diffing.quarkslab.com/tutorials/ex1_string_decipher.html


Solution #01: String Deciphering

⇒ The malware is mirai (first seen in 2016)

ciphered strings in .rodata

⇒

deciphering function calls

cross ref to 
data section

void sub_804F7E0(char *str1,
                 char *str2) {
   int size = strlen(str1);
   for (int i = 0; i < size; 
++i)
       str1[i] = str1[i] ^ 0x37;
  
   size = strlen(str2);
   for (int i = 0; i < size; 
++i)
       str2[i] = str2[i] ^ 0x37;
}

⇒

deciphering pseudo-code

1717



Binary Diffing



Intro Diffing

Use-cases:
→ malware diffing
→ patch analysis
→ anti-plagiarism
→ statically linked libraries identification
→ symbol porting (e.g: IDA annotations to a new version of a binary)
→ backdoor detection (if a program has been modified)

Goal is comparing two (or more) binaries to analyze theirs differences. It usually done on 
functions (1-to-1) mapping computation.
(which can be problematic when functions are merged or split)

Introduction

1919



Differs

Diaphora Bindiff Radiff2 QBindiff Ghidriff

Language Python Java C Python Python

Disassembler

IDA ✔ ✔ ✘ ✔ ✘

Ghidra ✘ ✔ ✘ ✔ ✔

Binja ✘ ✔ ✘ ✔ ✘

Radare2 ✘ ✘ ✔ ✘ ✘

Exporter SQLite Binexport n/c Binexport
Quokka n/c

Scripting API ✔ ✘ n/c ✔ ✔?
Use decompiler ✔ ✘ ✘ ✘ n/c

Homemade
https://github.com/quarkslab/qbindiff

2020

Next
Bootstrap
Workshop!

You have to 
attend it ;)

https://github.com/joxeankoret/diaphora
https://www.zynamics.com/bindiff.html
https://r2wiki.readthedocs.io/en/latest/tools/radiff2/
https://github.com/quarkslab/qbindiff
https://github.com/quarkslab/qbindiff
https://clearbluejar.github.io/ghidriff/


Practical #02: Diffing CVE-2021-0308 patch

Diff the two version of the program to understand the CVE patch. 

Methodology:

➤ Export both binaries in BinExport

○ IDA: Plugin > BinExport

○ Ghidra: Export Progam > BinExport

➤ Run BinDiff on the exported files

➤ Open the BinDiff output with: $ bindiff --ui

➤ Identify the code or function affected by the CVE

Practical #02: Manual Diffing

2121

We built the largest dataset of real-world CVEs with both vulns/patched versions.
There are ~2000 CVEs. Its available here: https://github.com/quarkslab/aosp_dataset

Info

https://github.com/quarkslab/aosp_dataset


Solution #02: Diffing CVE patch

⇒

Function 
patched!

2222



Scripting Bindiff

Problem
Bindiff made for manual diffing (with UI)

⇓
Thus cannot analyze the diff result in a 

programmatic way

➤ Python API to launch Bindiff on two binaries

➤ Enable scripting the diff result (to analyse it)

➤ Can automate diffing whole filesystem

Python-bindiff 

2323

https://github.com/quarkslab/python-bindiff


Python-bindiff

Light-mode Full-mode

Open diff file (.Bindiff) object and 
provide an API to manipulate it.

Open diff file and map the result on the 
two ProgramBinExport objects.

(slower as requires loading the two files)

from bindiff import BinDiff

# Diff two already exported binaries

diff = BinDiff.from_binexport_files(

    "primary.BinExport", "secondary.BinExport", "output.BinDiff"

)

# Diff from executable (will call IDA Pro and binexport)

BinDiff.from_binary_files("primary", "secondary", "output.BinDiff")

from bindiff import BinDiffFile

# Load a pre-existing BinDiff file

diff = BindiffFile("result.BinDiff")

from bindiff import BinDiff

from binexport import ProgramBinExport

p1 = ProgramBinExport("sample1.BinExport")

p2 = ProgramBinExport("sample2.BinExport")

diff = BinDiff(p1, p2, "output.BinDiff")

Running a Diff

2424



Practical #03a: Scripting Diffing Result

There are two binaries which one is stripped. The goal is to 

automatically port symbols to the stripped binary.

Methodology:

➤ Generate the diff automatically with python-bindiff

➤ Find functions changed/added/remove and output a summary

➤ For matched function add a symbol in the stripped binary

Practical #03a
Tip    : Add symbols in the ELF using LIEF!

# List static symbols

binary = lief.parse("./binary")

for symbol in binary.static_symbols:

    pass

# Add new static symbol

sym = lief.Symbol(...)

binary.add_static_symbol(sym) 25 25

Link: https://diffing.quarkslab.com/tutorials/03a_diffing_porting_symbols.html

LIEF

https://lief.quarkslab.com

https://diffing.quarkslab.com/tutorials/03a_diffing_porting_symbols.html


Solution #03b: Symbol Porting

(before symbols porting) (after symbols porting)

⇒

2626

libsensorservice-2.so



Automating
Firmware

Binary Diffing
(batch diffing)



Batch Binary Diffing

Use-Case
Analyzing a firmware update

Problematic
Diffing the whole filesystem

How
Doing batch diffing

2828



Firmware Diffing

1. Firmware Extraction

2. Firmware Cartography

3. Firmware Analysis & Diffing

Extraction
⇒ Complex tasks, the reference is unblob

docker run \
  --rm \
  --pull always \
  -v /path/to/extract-dir/on/host:/data/output \
  -v /path/to/files/on/host:/data/input \
  ghcr.io/onekey-sec/unblob:latest /data/input/path/to/file

Cartography
The goal is having a component overview.

    ⇒ Pyrrha       takes filesystem and maps 
programs and their dependencies
    ⇒ Mostly a GUI to vizualize graphs
pyrrha fs ROOT_DIRECTORY

Analysis & Diffing
Given two rootfs we can:

● Usual diffing on text files
● Automate bindiff diffing of programs

⇒ Explore results to understand changes 2929

https://github.com/quarkslab/pyrrha


Practical #04a: Netgear RAX30

You are given two firmware images for a Netgear RAX30 router. The 
latter is thus an update.
➤ Extract the firmware with unblob
➤ Start exploring extracted files

Practical #04a: Firmware Extraction

Netgear RAX30

3030

Use-case: Netgear RAX30 Router
⇒ Part of the pwn2own 2022 contest

Versions:
● V1.0.7.78_1

● V1.0.9.90_3 (released a day before pwn2own submissions!)

Goal: Identifying what has been patched!

docker run \
  --rm \
  --pull always \
  -v /path/to/extract-dir/on/host:/data/output \
  -v /path/to/files/on/host:/data/input \
  ghcr.io/onekey-sec/unblob:latest /data/input/path/to/file



Practical #04b: Cartography

➤ Load the first firmware (1.0.7.78) rootfs in Pyrrha 
➤ Find the binaries using curl_easy_setopt
➤ Export executables using this function (with BinExport)

Bonus: Script the check for that flag to identify weak binaries

Practical #04b: Firmware Cartography

3131

⇒ We identified that the router is fetching its firmware updates using libcurl.

⇒ Enabling SSL certificate checks when fetching an URL is done through:
● CURLOPT_SSL_VERIFYHOST

● CURLOPT_SSL_VERIFYPEER

⇒ These options can be set using curl_easy_setopt

Goal: Checking if all binaries using libcurl are properly using SSL (spoiler they did not..)

Background

Pyrrha files:
https://bit.ly/rax30_pyrrha

https://bit.ly/rax30_pyrrha


Practical #04c: Cartography diffing

➤ Diff the two Pyrrha graph dumps

Can use: https://github.com/quarkslab/pyrrha/blob/main/examples/diffing_pyrrha_exports.py

Practical #04c: Cartography Diffing

3232

Before diffing executable at binary level we can:

● diff the two directories with meld etc. (files added/removed)
● diff the two cartography (dependencies added/removed)

Goal ⇒ Having a broad overview of changes.

Background



Practical #04d: Whole firmware diffing

➤ Diff all the binaries using: Bindiff.raw_diffing(p1, p2, out)

➤ Load diffs with BinDiffFile(file) (one by one)

➤ Print executables that have changed the most!

Practical #04d: Firmware Diffing

3333

Link: https://diffing.quarkslab.com/tutorials/04c_firmware_diffing.html

Binexports:
https://bit.ly/rax30-binexports

https://diffing.quarkslab.com/tutorials/04c_firmware_diffing.html
https://bit.ly/rax30-binexports


A Glimpse of QBindiff

3434

Core Principle:
Diffing essentially made of two components:
Similarity & Topology (and arbitrate the two)

How: Solve the Network Alignment Quadratic 
Problem through a Belief propagation algorithm 
based on message passing.

Corollary: Anything that can be encoded as 
features and a graph can be diffed! (QBinDiff 
designed to be highly modular)

https://blog.quarkslab.com/qbindiff-a-modular-diffing-toolkit.html

https://blog.quarkslab.com/qbindiff-a-modular-diffing-toolkit.html


Conclusion

3535

Takeaways:

➢ automating the full diffing process

➢ manipulating a diff programmatically

➢ full firmware (file system) diffing for 
patch-diffing and vulnerability research

➢ QBinDiff relevant for advanced diffing 
scenarios


